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保証 2

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証しま
す。この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の
費用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使
用する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再
生品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知し
ていただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包して
いただき、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送さ
れる場合において、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返
送費用を負担します。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の
費用をお客様に負担していただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障ま
たは損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を
負いません。a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷
に対する修理。b）不適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製で
はないサプライ用品の使用により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品
と統合された場合において、改造または統合の影響により当該本製品のサービスの時間または難度が増加し
たときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。





目次

目次

安全にご使用いただくために.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

まえがき . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

主要な機能.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

対応製品.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

マニュアル . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

ソフトウェア・アップグレード. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

このマニュアルで使用される表記規則 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii

機器の設置.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

スタンダード・アクセサリ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

推奨アクセサリ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

動作の要件 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

機器の電源をオンにする. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

機器の電源をオフにする. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

電源コードの取り外し . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

ネットワークヘの接続 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

機器の概要.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

前面パネル.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

後部および側面パネル .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

入力接続の要件 - SD/HD オプション . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

入力接続の要件 - VGA オプション . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

入力信号の接続.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

信号パス補正 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

同期ピックオフの補正 - VM6000 および DPO7000 シリーズ、SD/HD オプションのみ .. . . . . . . . . . . . . . 21

同期ピックオフの補正 - VM5000 および TDS5000 シリーズ、SD/HD オプションのみ . . . . . . . . . . . . . . . . 22

マトリクス・テスト信号について .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

VM シリーズ・システム・ソフトウェアの起動 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

VM シリーズ・システム・ソフトウェアのユーザ・インタフェース . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

測定の実行手順.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

DUT の設定 - VGA オプション . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

入力信号フォーマットの設定 - SD/HD オプション ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

入力信号フォーマットの設定 - VGA オプション ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

測定の選択 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

測定実行操作の設定 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

測定の実行と表示 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

オシロスコープの使用.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

信号問題のトラブルシューティング . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

アプリケーション . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

基本的なカラー・バー測定 – SD/HD オプション ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

基本的なカラー・バー測定 – VGA オプション ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

相対基準のカラー・バー測定の表示.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

リミット・テストを使用したカラー・バー測定の表示.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

2 つの測定を使用したリミット・テストの実行.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル i



目次

複数のラインにわたる測定の実施 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

入力信号のピクチャとしての表示 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

入力信号のベクトルスコープ・ウィンドウでの表示 – SD/HD オプションのみ.. . . . . . . . . . . . . . . . . . . . . . . . 78

索引

ii VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル



安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性
に関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があり
ます。 システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルに
ある安全に関するセクションをお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コー
ドのみを使用してください。

接続と切断は正しく行ってください。 プローブと検査リードは、電圧ソースに接続されている間は接続ま
たは切断しないでください。

接続と切断は正しく行ってください。 被測定回路の電源を切ってから、電流プローブの接続ある
いは切断を行ってください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避け
るため、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品
が正しく接地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべて
の定格とマーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マ
ニュアルを参照してください。

入力は、メイン、カテゴリ II、 III、および IV 回路に対しては、定格化されていません。

電流プローブを、その定格電圧を超える電圧がかかっている電線に接続しないでください。

電源を切断してください。 電源スイッチにより、電源から製品を切断します。 位置については、使用
説明書を参照してください。 電源スイッチをさえぎらないでください。このスイッチは常にユーザが操作
可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作
させないでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のあ
るサービス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れ
ないでください。

適切なヒューズを使用してください。 本製品用に指定されたタイプおよび定格のヒューズのみを使
用してください。
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安全にご使用いただくために

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュ
アルの設置方法を参照してください。

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

「危険」マークが表示されている場合、怪我をする危険が切迫していることを示します。

「警告」マークが表示されている場合、怪我をする可能性があることを示します。

「注意」マークが表示されている場合、本製品を含む資産に損害が生じる可能性があることを示します。

本製品では、次の記号を使用します。
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まえがき

まえがき

このマニュアルは、VM シリーズ・ビデオ測定システムの設置と基本的な操作について説明しています。
詳細については、機器のオンライン・マニュアルおよび『VM シリーズ・ビデオ測定システム・ユーザ・マ
ニュアル』を参照してください。

主要な機能
VM シリーズ・ビデオ測定システムは、オシロスコープ・プラットフォームをベースとした高性能な自動ビデオ
測定システムです。主要な機能は次の通りです。

高速で正確な信頼性の高いビデオ測定

包括的なコンポーネント・アナログ信号解析

PC およびデジタル TV 用の一般向けビデオ・デバイスの自動テスト

PC グラフィックス・デバイス向けの自動化された VESA 適合性テスト

オプションによる SD、HDTV、および RGBHV コンポーネント・アナログ・ビデオ・フォーマットのサポート

ピクチャ、ベクトル、および波形表示

統合された合否リミット・テスト

コンパニオン・テスト信号パッケージ

GPIB リモート・コントロールと LAN 接続

完全なオシロスコープ機能

対応製品
VM シリーズ・ビデオ測定システムは、ソフトウェアとハードウェアを組み合わせたパッケージとして販売され
ています。このパッケージは既存の Tektronix 製オシロスコープにインストールできます。また、VM5000HD
型または VM5000 型システムへのアップグレードも可能です。VM シリーズ・ビデオ測定システムの対応製
品を以下に示します。一部、VGA に未対応の製品も含まれているのでご注意ください。

機器 対応オプション

VM5000HD 型 SD、HD、VGA

VM5000 型 SD、HD、VGA

TDS 5104 型 SD、HD、VGA

TDS 5104B 型 SD、HD、VGA

TDS 5054 型 SD、HD

TDS 5054B 型 SD、HD

DPO 7254 型 SD、HD、VGA

DPO 7104 型 SD、HD、VGA

DPO 7054 型 SD、HD
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マニュアル

参照する項目 使用するマニュアル

設置と操作（概要） VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・
マニュアル：機器を動作させる方法、ユーザ・インタフェース・
コントロールのガイド、および使用例に関する一般的な情報
が記載されています。

詳細な操作とユーザ・インタフェース
に関するヘルプ

VM シリーズ・ビデオ測定システム・ユーザ・マニュアル：機器
の詳細な操作方法（測定値の計算方法、仕様など）が記載さ
れています。

VM シリーズ・ビデオ測定システム・オンライン・ヘルプ：ディスプ
レイ上の操作部については、オンライン・ヘルプ（ソフトウェアの
Help メニューからアクセス）を参照してください。

プログラミング・コマンド VM シリーズ・ビデオ測定システム・プログラマ・マニュアル：VM
シリーズビデオ測定システムに固有のプログラミング・コマンドは、
VM シリーズビデオ測定システム製品のソフトウェア CD-ROM
に収録されている、PDF ファイルに記載されています。オシロス
コープのプログラマ・マニュアルは、オシロスコープの製品ソフト
ウェア CD-ROM に収録されている PDF ファイルです。

オシロスコープの使用 オシロスコープ自体の機能については、各オシロスコープのマ
ニュアルを参照してください。

ユーザ・サービスと性能検査 オシロスコープのサービス・マニュアルを参照してください。

ソフトウェア・アップグレード
ソフトウェア・アップグレードを定期的に入手できます。特定のオシロスコープ・モデルとシリアル番号に対し
て有効なオプション・キーを所有している場合にのみ、ソフトウェアが動作します。

アップグレードを確認するには：

1. Tektronix ホームページ（www.tektronix.com）にアクセスします。

2. Software and Firmware Finder（ソフトウェアとファームウェアの検索）Web ページにリンクしているSoftware
and Drivers（ソフトウェアとドライバ）を選択します。

3. 製品名（VM シリーズ）を入力して、入手可能なソフトウェア・アップグレードを検索します。
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このマニュアルで使用される表記規則
このマニュアルでは、VM シリーズ・ビデオ測定システムの、SD、HD、VGA の各オプションの操作方法につ
いて説明します。操作の方法はどのオプションでも同じですが、機能の点で異なる部分があり、特に、利用
できる測定値が異なっています。さらに、VM シリーズ・ビデオ測定システム用のソフトウェアおよびアクセサ
リを、当社のオシロスコープの機種に合わせて購入できます。設定やアプリケーションの相違については、
該当するオプションの名前、またはオシロスコープ・プラットフォームを明記のうえ、説明します。画面表示の
相違については、SD/HD オプションと VGA オプションの両バージョンを示します。

このマニュアルでは、次のアイコンが使用されています。

順番に行う
手順

前面パネル
の電源

電源の接
続

ネットワーク PS2 SVGA USB
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機器の設置

機器の設置

このセクションでは、機器の設置方法について解説します。機器を開梱し、スタンダード・アクセサリとして
記載されているすべての付属品が含まれていることを確認してください。また、機器と一緒に購入した
アクセサリが含まれていることも確認してください。最新の情報については、Tektronix のホームページ
（www.tektronix.com）をご覧ください。

スタンダード・アクセサリ

VM シリーズ・ビデオ測定システムのスタンダード・アクセサリ

アクセサリ 部品番号

VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル（英語版）：
言語オプションが注文された場合は、フランス語、ドイツ語、スペイン語、繁体字中
国語、簡体字中国語、または日本語の翻訳版が付属

071-2091-XX

VM シリーズ・ビデオ測定システム・ユーザ・マニュアル 071-2103-XX

VM シリーズ・ビデオ測定システム・プログラマ・マニュアル（PDF 形式）：VM シリー
ズ・ビデオ測定システムの製品ソフトウェア CD に収録

071-2104-XX

DPO7000/DSA70000/DPO70000 シリーズ・デジタル・フォスファ・オシロスコープの
クイック・スタート・ユーザ・マニュアル

071-1733-xx

VM シリーズ・ビデオ測定システム製品ソフトウェア CD-ROM：VM シリーズ・ビデオ測
定システムの製品ソフトウェアのほか、オンライン・マニュアル、『VM シリーズ・ビデオ測
定システム・ユーザ・マニュアル（PDF 版）』、『VM シリーズ・ビデオ測定システム・クイッ
ク・スタート・ユーザ・マニュアル（PDF 版）』、リリース・ノートを収録

020-2767-XX

DPO7000/DSA70000/DPO70000 シリーズ製品ソフトウェア CD 020-2693-xx

DPO7000/DSA70000/DPO70000 シリーズ・オペレーティング・システム・リストア CD 020-2659-xx

Tek リストア・ソフトウェア・ライセンス（リカバリ・メディア／OS リストア用） —

オプション・アプリケーション・ソフトウェア CD とマニュアル・キット 020-2700-xx

Getting Started with OpenChoice Solutions キット 020-2513-xx

DPO7000/DSA70000/DPO70000 シリーズ・オンライン・ヘルプ（製品ソフトウェアの
一部）

—

DPO7000/DSA70000/DPO70000 シリーズ・パフォーマンス検証（製品ソフトウェア
CD に収録されている PDF ファイル）

—

DPO7000/DSA70000/DPO70000 シリーズ・プログラマ・オンライン・ガイド（製品ソフト
ウェア CD に収録されているファイル）

—

NIST、Z540-1、および ISO9000 の校正証明書 —

マウス（オプティカル） 119-7054-xx

ミニ・キーボード（2 ポート・ハブ付き USB 接続） 118-7083-XX

前面カバー 200-4963-xx

アクセサリ・ポーチ 016-1966-xx

プローブ校正およびデスキュー・アダプタ（説明書付き） 067-0405-xx

Nero OEM ソフトウェア CD 063-3781-xx
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機器の設置

VM シリーズ・ビデオ測定システムのスタンダード・アクセサリ （続く）

アクセサリ 部品番号

TPA-BNC サービス交換アダプタ
（SD/HD オプションの場合 1 個、VGA オプションの場合 4
個）

013-0355-02

高確度 75 Ω ターミネーション（4） 011-0102-XX

BNC T 型コネクタ（4） 103-0030-XX

同期用ピックオフ・ケーブル（SD/HD オプションのみ） 012-1680-XX

VGA - BNC 5X ケーブル（6 インチ長）（VGA オプションのみ） 174-5147-XX

VGA - BNC 5X ケーブル（3 フィート長）（VGA オプションのみ） 174-5216-XX

RGBHV 測定インタフェース・ユニット（VGA オプションのみ） 012-1685-XX

RS-232 RGBHV MIU コントロール・ケーブル（VGA オプションのみ） 012-1692-XX

BNC - 電極柱アダプタ（2）（VGA オプションのみ） 011-0183-00

2.21 kΩ 抵抗器 322-3226-00

301 Ω 抵抗器 322-3143-00

VGA 同期結合器ケーブル 012-1664-XX

北米（オプション A0） 161-0104-00

欧州全域（オプション A1） 161-0104-06

英国（オプション A2） 161-0104-07

オーストラリア（オプション A3） 161-0104-05

スイス（オプション A5） 161-0167-00

日本（オプション A6) 161-A005-00

中国（オプション A10） 161-0306-00

インド（オプション A11） 161-0324-00

電源コード

電源コードおよび AC アダプタなし（オプション A99） ―
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機器の設置

推奨アクセサリ
お買い上げいただいた機器には、推奨アクセサリも含まれている場合があります。ご注文のオプショナル・
アクセサリが機器に含まれていることを確認してください。

VM シリーズ・ビデオ測定システムの推奨アクセサリ 1

アクセサリ 部品番号

VM シリーズ信号源（480 ライン DVD および 580 ライン DVD） 020-2770-XX

VM シリーズ信号源（標準定義基本ストリーム） 020-2771-XX

VM シリーズ信号源（拡張 TV 基本ストリーム） 020-2772-XX

VM シリーズ信号源（ATSC トランスポート・ストリーム） 020-2773-XX

VM シリーズ信号源（ベースバンド・テスト信号） 020-2774-XX

VM シリーズ信号源（PC ビットマップ・グラフィックス・テスト信号ファイル） 020-2775-XX

VM シリーズ信号源（H.264 SD および HD ストリーム） 020-2776-XX

DPO70000 シリーズ・デジタル・フォスファ・オシロスコープ・サービス・マニュアル 071-1174-XX

運搬用ケース 016-1942-00

プローブ校正、補正、およびデスキュー用アダプタ 067-0405-XX

電力デスキュー・フィクスチャ 067-1478-00

ビデオ・ディスプレイ・クランプ 013-0278-XX

P5050 型 500MHz 10:1 受動プローブ P5050 型

GPIB ケーブル（1 m） 012-0991-01

GPIB ケーブル（2 m） 012-0991-00

セントロニクス（プリンタ）ケーブル 012-1214-00

1 お使いの VM シリーズ・ビデオ測定システム用に提供されているアクセサリ、アップグレード、オプション、サービス・オプションの
最新リストについては、Tektronix ホームページ（www.tektronix.com）にアクセスしてください。
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機器の設置

動作の要件

1. 次のスペース要件を確認し、カート
またはベンチに機器を設置します。

上部、後部、前面、および右
側： 0 mm（0 インチ）

左側： 76 mm（3 インチ）

底部： 最小 19 mm（0.75 イン
チ）または 0 mm（0 インチ、脚を
取り付けて下ろした場合）

2. 操作する前に、環境温度が +5 °C
～ +45 °C（+41 °F ～ +113 °F）
であることを確認してください。

注意： 正しく冷却するために、機器の底面と側面には障害物を置かないでください。

機器の電源をオンにする

電源要件

電源電圧と周波数 電力消費量

100 ～ 240 VRMS ±10%、47 ～ 63 Hz または 115
VRMS ±10%、360 ～ 440 Hz

最大 550 ワット
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機器の設置

機器の電源をオフにする

電源コードの取り外し

ネットワークヘの接続

機器をネットワークに接続して、印刷、
ファイル共有、インターネット・アクセ
スなどの機能を利用できます。ネット
ワークに対して機器を設定するには、
ネットワーク管理者に問い合わせ、標
準の Windows ユーティリティを使用し
てください。
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機器の概要

機器の概要

前面パネル

1. DVD/CD-RW ドライブ

2. 前面パネル・コントロール

3. USB ポート

4. グランド端子

5. 補助トリガ入力

6. チャンネル 1-4 入力

7. プローブ校正出力

8. プローブ補正出力
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機器の概要

後部および側面パネル

1. USB ポート

2. サイドバイサイド表示用のモニタを
接続するビデオ・ポート

3. マイク・コネクタ（マイクロフォン用）

4. ライン・アウト・コネクタ（スピーカ接
続用）

5. XGA ビデオ出力ポート（オシロス
コープのみ、モニタ接続用）

6. プリンタ接続

7. ライン・イン・コネクタ

8. ネットワーク接続用 RJ-45 LAN コ
ネクタ

9. セントロニクス・パラレル・ポート

10.COM1 シリアル・ポート

11.マウス用 PS-2 コネクタ

12.キーボード用 PS-2 コネクタ

13.TekLink コネクタ（未使用）

14. リムーバブル・ハードディスク・ドラ
イブ

15.コントローラ接続用 GPIB ポート

16.補助出力

17.チャンネル 3 出力

18.外部リファレンス入力
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機器の概要

入力接続の要件 - SD/HD オプション
機器に被測定ビデオ装置を接続する場合は、75 Ω の同軸ケーブルのみを使用してください。

付属の BNC T 型コネクタを使用して、
同軸ケーブルの終端と機器の入力
チャンネル間に付属の 75 Ω 終端を装
着します。正確な周波数応答を測定
するには、T コネクタを入力チャンネル
BNC に直接接続することが重要です。

入力接続の要件 - VGA オプション

被測定ビデオ装置を機器に接続す
る場合は、RGBHV 測定インタフェー
ス・ユニットを使用することをお勧めし
ます。測定インタフェース・ユニットに
は、正確な測定結果を保証するため、
インピーダンス整合回路が備わってい
ます。測定に応じて、低周波パスが使
用される場合と広帯域パスが使用され
る場合があります。VM シリーズ・シス
テムでは、測定インタフェース・ユニッ
トへの RS-232 接続を通して、使用さ
れるパスが選択されます。

付属の VGA コネクタ -5X ケーブルを
使用して、被測定ビデオ装置を VM シ
リーズ・システムに接続することもでき
ます。この方法を使用する場合は、付
属の高確度ターミネーションを使用し
てケーブルを VM シリーズ・システム
に接続する必要があります。また、測
定によっては、その実行中に手動で
ターミネーションを変更しなければな
らない場合があります。
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機器の概要

入力信号の接続

SD/HD オプションのセットアップ 1

セットアップ 1 は、Y/G でコンポジット同期信号を持つ 3 ワイヤ・コンポーネントのアナログ・ビデオ信号（Y/G、
Pb/B、Pr/R）をテストする場合に使用してください。これらのセットアップは、同期ピックオフ・アクセサリを使
用して、CH1 の Y/G 信号からトリガ信号を供給します。トリガ・ソースは、チャンネル 4 に設定されます。この
設定では、セットアップ 2 より正確な低レベルのノイズ測定（30 MHz 帯域幅で -60dB 未満）を実現します。

このタイプの接続を使用すると、CH1 と CH4 間にケーブルを追加しなくても、CH4 でトリガを実行しながら、
CH1 でより正確なノイズ測定を実行することができます。ケーブルを追加すると、周波数の応答やマルチ
バースト測定に悪影響が生じる可能性があります。

最良の周波数応答とマルチバースト測定を実行するには、セットアップの図に示されているように、75 Ω の
ターミネーションを入力コネクタのできるだけ近くに接続してください。

VM シリーズ・システムに同期ピックオフを接続する方法には、2 通りがあります。1 つは、同期ピックオフを
入力に直接接続する方法、もう 1 つは、75 Ω ターミネーションに装着した T コネクタを通して接続するとい
う方法です。使用する同期ピックオフのバージョンに応じて選択してください。

セットアップ 1A - 同期用ピックオフ 012-1680-01 でコンポジット同期を使用する 3 ワイヤのアナ
ログ･ビデオ012-1680-01 同期ピックオフ （75 Ω ターミネーションを内蔵）を使用する場合は、次の図に示
されているように、VM6000、DPO7000 シリーズ機器用 TPA-BNC アダプタを使用して同期ピックオフを VM
シリーズ・システムの CH1 入力に直接接続します。012-1680-00 同期ピックオフ（外部の 75 Ω ターミネー
ションが必要）を使用する場合は、セットアップ 1B の図に従ってください。

VM6000/DPO7000 シリーズの機器への接続
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機器の概要

VM5000/TDS5000 シリーズの機器への接続

セットアップ 1B - 同期ピックオフ 012-1680-00 でコンポジット同期を使用する 3 ワイヤのアナロ
グ・ビデオ012-1680-00 同期ピックオフ（部品番号は大きなモジュールのラベルに記載）を使用する場合
は、次の図に示されているように、同期ピックオフを VM シリーズ・システムの CH1 入力に接続します。
012-1680-01 同期ピックオフを使用する場合は、セットアップ 1A の図に従ってください。

VM6000/DPO7000 シリーズの機器への接続
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機器の概要

VM5000/TDS5000 シリーズの機器への接続

次の図は、012-1680-00 同期ピックオフを CH1 入力に接続する方法を示しています。

注： トリガ・チャンネルがチャンネル 4 （デフォルト設定）に設定されていることを確認します。 トリガの設定
（Configuration（設定） > Operation（操作））が CH4 に設定されていない場合は、信号の警告メッセージ
が表示され、測定を実行することができません。
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機器の概要

SD/HD オプションのセットアップ 2 - コンポジット同期を使用する 3 ワイヤ・アナロ
グ・ビデオ

Y/G でコンポジット同期信号を持つ 3 ワイヤ・コンポーネントのアナログ・ビデオ信号（Y/G、Pb/B、Pr/R）を
テストする場合は、このセットアップを使用します。機器のトリガを CH1 に設定します（デフォルトのトリガ設
定は CH4 です）。このセットアップは、ここで説明する他のセットアップより簡単ですが、Y/G のノイズ測定
は -65 dB に制限されます（30 MHzのノイズ帯域）。

VM6000/DPO7000 シリーズの機器への接続

VM5000/TDS5000 シリーズの機器への接続
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機器の概要

SD/HD オプションのセットアップ 3 - 別のコンポジット同期を使用する 4 ワイヤ・ア
ナログ・ビデオ

異なる出力ラインでコンポジット同期信号を持つ 4 ワイヤ・コンポーネントのアナログ・ビデオ信号（Y/G、
Pb/B、Pr/R）をテストする場合は、このセットアップを使用します。 CH4 のみの場合は、終端を使用せずに信
号を接続できます。または、機器に付属の 75 Ω 終端より精度が低い 75 Ω 終端を使用することができます。

VM6000/DPO7000 シリーズの機器への接続

VM5000/TDS5000 シリーズの機器への接続

注： トリガ・チャンネルがチャンネル 4（デフォルトのトリガ・チャンネル）に設定されていることを確認しま
す。 トリガの設定が CH4 に設定されていない場合は(Configuration（設定） > Operation（操作））、信号
の警告メッセージが表示され、測定を実行することができません。
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機器の概要

VGA オプションのセットアップ 1 - RGBHV 測定インタフェース・ユニット

これは、PC およびビデオ再生デバイスをテストする場合に推奨されるセットアップです。RGBHV 測定インタ
フェース・ユニットを使用して、VM シリーズ・システムに PC のビデオ・カードを接続します。RGBHV MIU を
使用すると、最も正確な測定結果を得られます。

VM6000/DPO7000 シリーズの機器への接続

14 VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル



機器の概要

VM5000/TDS5000 シリーズの機器への接続

RGBHV 測定インタフェース・ユニットを接続するには

1. VM シリーズ・システムに付属の
VGA-BNC アダプタ・ケーブルを
使用して、被測定装置（DUT）を
RGBHV 測定インタフェース・ユニッ
トの入力側に接続します。
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機器の概要

2. RGBHC 測定インタフェース・ユニッ
トの出力（補助、CH1 ～ CH4）を
VM シリーズ・システムの同じ入力
に接続します（つまり、CH1 出力を
CH1 入力に接続します）。

VM6000/DPO7000 シリーズの機器

VM5000/TDS5000 シリーズ
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機器の概要

3. RGBHV 測定インタフェース・ユ
ニットと VM シリーズ・システムの
COM1 ポートを RS-232 ケーブル
で接続します。

4. Configuration（設定） > Operation
（操作）タブのUse MIU（MIUの使
用）チェックボックスが選択されて
いることを確認します。
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機器の概要

VGA オプションのセットアップ 2 - 5X ケーブルへの VGA コネクタ

RGBHV 測定インタフェース・ユニットを使いにくい場合に、PC やビデオ再生デバイスをテストするには、こ
のセットアップを使用します。正確な測定を実行するため、CH1 ～ CH4 で T 型コネクタと高確度ターミネー
ションを使用して、VM シリーズ・システムに信号を接続します。CH1 ～ CH3（GBRで使用）では 75 Ω の
ターミネーション、CH4（H および V 同期測定で使用）では 2.21 kΩ と 301 Ω のターミネーションを使用
する必要があります。この方法では、特定の水平および垂直測定に対して、CH4 での信号およびター
ミネーション接続の変更が必要です。VM シリーズ・システムにより、これらを必要に応じて変更するよう
要求するダイアログ・ボックスが表示されます（RGBHV 測定インタフェース・ユニットでは、これらの接続
とターミネーションは内部的に変更されます）。

VGA-5X ケーブルを使用して、VM シリーズ・システムに DUT を接続するには：

1. 付属の BNC T 型コネクタを使用し
て、BNC ケーブルの終端と機器の
1 ～ 3 の入力チャンネル間に付属
の 75 Ω 終端を装着します。正確
な測定を実行するには、T コネクタ
を入力チャンネル BNC に直接接
続することが重要です。

2. H 同期、V 同期、V タイミング測
定を実行する場合は、スタンダー
ド・アクセサリとして付属している
BNC- 電極柱アダプタと抵抗器を
使用して、2.21 kΩ と 301 Ω の終
端を行う必要があります。 図のよ
うに各抵抗器をアダプタに接続し
ます。
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機器の概要

3. 図のように、VM シリーズ・システム
を VGA 信号に接続します。まず、
2.21 kΩ ターミネーションを使用し
て、H 同期信号を接続します。VM
シリーズ・システムにより、必要に
応じて、301 Ω ターミネーションに
変更するよう要求されます。

VM6000/DPO7000 シリーズの機器

VM5000/TDS5000 シリーズの機器
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機器の概要

H 同期測定を実行している場合に、
CH4 で信号終端を変更するよう、ポッ
プアップ警告メッセージが表示され
ます。

次の表は、DUT からのどの信号を VM シリーズ・システムのどの入力コネクタに接続するかと、各信号で使
用する必要のあるターミネーションを示しています。

VGA 信号
VM シリーズ・システムの入力
コネクタ 終端

緑 CH 1 75 Ω

青 CH 2 75 Ω

赤 CH 3 75 Ω

H 同期 CH 4 1 2.21 kΩ および 301 Ω

V 同期 AUX None（なし）

1 V 同期信号は、V タイミングまたは V 同期測定を実行する場合に、このチャンネルに接続されます。VM シリーズ・システムによ
り、必要な場合にこの接続を変更するように要求されます。
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機器の概要

信号パス補正
最適な測定確度を得るには、信号パスの補正が必要です。オシロスコープのオンライン・ヘルプに従って
実行してください。最後に信号パス補正が実行されてから温度が 5 ℃以上変化した場合は、この手順
を実行します。信号パス補正は、週に一度実行してください。補正を行わない場合、V/div 設定では機
器は保証されている性能レベルを満たさない可能性があります。

同期ピックオフの補正 - VM6000 および DPO7000 シリーズ、SD/HD
オプションのみ

同期ピックオフを正しく補正するには

1. 同期ピックオフの、小さい方の
ハウジング（"Connect to Trigger
Channel" と表示されている方）を
CH4 に接続します。大きい方のハ
ウジングは機器に接続しないでお
いてください。

2. 同期ピックオフの BNC コネクタを
BNC- ミニグラバ・コネクタに取り付
けます（Pomona Electronics モデ
ル番号 3789）。

3. PROBE COMP（プローブ補正）コ
ネクタにミニグラバを接続します。
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機器の概要

4. AUTOSET を押します。

5. 表示される波形の形状をチェックし
て、同期用ピックオフが正しく補正
されていることを確認します。

6. 必要に応じて同期ピックオフを調
整します。必要なだけ調整を繰り
返します。

同期ピックオフの補正 - VM5000 および TDS5000 シリーズ、SD/HD
オプションのみ

同期ピックオフを正しく補正するには

1. 同期ピックオフ・ケーブルを CH1
および CH4 に接続します。小さ
い方のハウジング（"Connect to
Trigger Channel" と表示されている
方）を CH4 に接続します。
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機器の概要

2. 同期ピックオフ BNC コネクタを
BNC- ミニグラバ・コネクタに取り付
けます（Pomona Electronics モデ
ル番号 3789）。

3. PROBE COMP（プローブ補正）コ
ネクタにミニグラバを接続します。

4. CH1 および CH4 を選択します。
FastAcq を押します。AUTOSET を
押します。

CH1 と CH4 の両方の波形が表示
されます。波形が傾いて表示され
るのは正常です。これは 75 Ω の
同期ピックオフ・ターミネーションに
PROBE COMP 出力信号が取り込
まれているためです。

5. 表示される波形の形状をチェックし
て、同期用ピックオフが正しく補正
されていることを確認します。

適切な補正

補正不足
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機器の概要

過度の補正

6. 必要に応じて同期ピックオフを調
整します。必要なだけ調整を繰り
返します。
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機器の概要

マトリクス・テスト信号について
マトリクス・テスト信号は、この製品に含まれているアクセサリ信号源ディスクで提供されます。SD および HD
オプションのマトリクス信号と VGA オプションのマトリクス信号があります。マトリクス信号は、すべてのアナロ
グ・ビデオ信号要件を 1 つのテスト・パターン・フィールドの各ラインに挿入したものです。信号のテスト・パ
ターンを使用すると、異なる測定を実行する場合に、テスト信号を変更する必要がなくなります。実行する測
定でライン番号を指定するだけで測定を変更できます。使用するマトリクス・テスト信号のフォーマットに一致
するセットアップ・ファイル（.vmset）を使用します。これにより、各測定タイプのデフォルト設定として、正しい
ライン番号が提供されます。信号源ディスクに収録されているファイルの詳細については、『VM シリー
ズ・ビデオ測定システム・ユーザ・マニュアル』を参照してください。

SD/HD オプションのマトリクス信号
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機器の概要

SD/HD オプションのマトリクス信号要素

信号名
フォー
マット 信号名

フォー
マット 信号名

フォー
マット

1. カラー・バー All（す
べて）

7. YpbPr 掃引時
間

YPbPr 13. 有効なラン
プ

All（す
べて）

2. RGB パルス・
バー

RGB 8. YPbPr 掃引周
波数

YPbPr 14. YpbPr シャ
ロー・ランプ

YPbPr

3. RGB 周波数掃
引

RGB 9. YPbPr マルチ
バースト

YPbPr 15. RGB シャ
ロー・ランプ

RGB

4. RGB 時間掃引 RGB 10. YPbPr マルチ
バースト

YPbPr 16. フラット・
フィールド 7.5%

All（す
べて）

5. RGB マルチバー
スト

YPbPr 11. RGB クロストー
ク

RGB 17. フラット・
フィールド 50%

All（す
べて）

6. YPbPr パルス・
バー

YPbPr 12. YPbPr クロス
トーク

YPbPr 18. フラット・
フィールド 100%

All（す
べて）

VGA オプションのマトリクス信号

VGA オプションのマトリクス信号要素

信号名 信号名

1. 半分白と半分黒 5. 黒 / 白 / 黒

2. 9 つのカラーバー 6. 全面白

3. 32 ステップ 7. ランプ

4. 白と黒交互 8. 半分白と半分黒
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機器の概要

VM シリーズ・システム・ソフトウェアの起動

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video
または VM VGA Video を選択しま
す。

SD/HD オプション

VGA オプション
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機器の概要

機器の波形表示領域がディスプレ
イの上半分になり、下半分に VM
シリーズ・システム・アプリケーショ
ンが表示されます。

SD/HD オプション

VGA オプション
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機器の概要

VM シリーズ・システム・ソフトウェアのユーザ・インタフェース

1. メニュー・バー：設定コントロールを
選択し、アプリケーションに情報を
表示します。

2. アプリケーション表示：設定コント
ロールと測定結果を表示します。

3. Run ボタン：セットアップを開始し、
測定を実行して結果を表示します。

4. Stop（停止）ボタン：測定を停止し
ます。

5. Picture（ピクチャ）ボタン：信号をピ
クチャとして表示します。

6. Vectorscope（ベクトルスコープ）ボ
タン：ベクトルスコープのフォーマッ
トで信号を表示します。（SD/HD オ
プションのみ）

7. Hide(隠す）ボタン：メイン・ディスプ
レイをフルスクリーンに戻し、アプ
リケーションのウィンドウをその背
後に隠します。

Windows のデスクトップにアクセス
するには（レポート表示のため）、
Hide（隠す）を選択します。 メイン・
ディスプレイで、File（ファイル） >
Minimize（最小化）を選択してから、
アプリケーションのHide（隠す）ボタ
ンをもう一度選択します。
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機器の概要

8. 画面が非表示になっている
アプリケーションを前面に出
すには：Analyze メニューの
Restore Application を選択する
（VM60000/DPO7000 シリーズ）
か、App ボタンをクリックします
（VM5000/TDS5000 シリーズ）。

VM6000/DPO7000 シリーズ

VM5000/TDS5000 シリーズ

9. Exit ボタン：VM シリーズ・システ
ム・アプリケーションを終了し、機器
のデフォルトのメイン・ディスプレイ
に戻ります。
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機器の概要

測定の実行手順
1. Configuration（設定） > Format（フォーマット）を使用して、入力信号フォーマットのパラメータを設

定します。

2. Configuration（設定） > Measurements（測定）を使用して、実行する測定を 1 つまたは複数選択します。

3. Configuration（設定） > Operation（操作）を使用して、測定の実行操作を設定します。

4. Run（実行）ボタンを選択して、測定を実行して、表示します。

5. Utilities（ユーティリティ） > Generate Report（レポートの生成）を使用して、測定結果を保存します。

DUT の設定 - VGA オプション
DUT で測定を実行するには、VM シリーズ・システムに正しいビデオ信号を供給する必要があります。これ
は、DUT が動作する PC 上でビットマップ・ファイルを表示することで実現します。複数の測定を実行する場
合は、マトリクス信号のビットマップ・ファイルを使用します。測定を 1 回だけ実行する必要がある場合は、
マトリクス信号ではなく、フルフィールドのテスト・パターンを使用できます。VESA テスト手順（ディスプ
レイ・グラフィックス・サブシステムの評価（バージョン 1、リビジョン 1））の適合性をテストするのに必要
なすべてのマトリクス信号およびフルフィールドのテスト・パターン・ビットマップは、『PC ビットマップ・グ
ラフィックス・テスト信号ファイル』CD-ROM に収録されています。

1. DUT の解像度とリフレッシュ・レー
トを必要な値に設定します。

2. DUT を含む PC 上で、PC Bitmap
Graphics Test Signal Files（PCビッ
トマップ・グラフィックス・テスト信号
ファイル） CD-ROM の内容を表示
します。

3. Matrix（マトリクス）またはFull Field
（フル・フィールド）フォルダのいず
れかの内容を表示します。

複数の測定を実行する場合は、
Matrix（マトリクス）フォルダを開
きます。

測定を1回だけ実行する場合
は、Full Field（フル・フィールド）
フォルダを開き、次の表を使用
して、正しいテスト・パターンを
選択します。
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機器の概要

正しいフルフィールドのテスト・パターンに対する整合測定

測定 正しいテスト・パターン

Ch-Ch の不一致 32 ステップ階段波

Ch-Ch スキュー 白と黒交互

カラー・バー 9 つのカラー・バー

H 同期 任意のパターン

H 同期ジッタ 任意のパターン

H タイミング 黒 / 白 / 黒

直線性 階段波

ルミナンスのレベル 白と黒交互

ノイズ放射比 全面白

ビデオ・トランゼント 白と黒交互

V 同期 任意のパターン

V タイミング 半分白と半分黒

信号のテスト・パターンを選択する場合でも複数の測定を実行する場合でも、表示するビットマップ・ファ
イルを選択して、ビデオ・テスト信号を生成する必要があります。選択するファイルは、テストするフォー
マットによって異なります。1280X1024 解像度フォーマットのテストを実行すると考えてみましょう（ビット
マップ・ファイルの選択では、リフレッシュ・レートは考慮されません）。正しいフォルダ内で、実行す
るテストのフォーマットに一致するファイル名を探します。直線性をテストする場合は、フルフィールドの
階段波テスト・パターンを選択するか、マトリクス・テスト・パターンを使用します。Staircase（階段波）フォ
ルダ内で、STEP1280X1024.bmp という名前のファイルを探します。Matrix（マトリクス）フォルダ内で、
MAT1280X1024.bmp という名前のファイルを探します。

4. 要件に合ったビットマップ・ファイル
を選択し、Paint Shop Pro などのプ
ログラムでファイルを開きます。

2 台目のディスプレイを使用するた
めに DUT をセットアップしている
場合は、ファイルをビットマップ・エ
ディタで開かなくても、2 台目のディ
スプレイの背景をそのビットマップ・
ファイルに設定できます。
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機器の概要

5. View（表示）メニューから、View（表
示） > Full Screen Preview（フル・ス
クリーン・プレビュー）を選択します。

bmp ファイルがフル・スクリーン・
モードを使用して、境界なしで表
示されます。

6. モニタから DUT の出力を取り外
し、VM シリーズ・システムに DUT
の出力を接続します。

入力信号フォーマットの設定 - SD/HD オプション

1. Configuration（設定） > Format
（フォーマット）を選択します。

Format（フォーマット）画面が表示
されます。
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機器の概要

2. 測定する信号に適したビデオ・
フォーマットを選択します。

3. 測定する信号に適したカラー・ス
ペースを選択します。

カスタム・フォーマットの作成

Format タブにリストされていないフォーマットをテストする必要がある場合は、ユーザ定義のフォーマットを
作成できます。

1. Configuration > Format を選択し
ます。

Format タブ画面が表示されます。

2. 新しいフォーマットを追加する
には、Add を選択します。すると
Create User Defined Format ウィン
ドウが表示されます。
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機器の概要

3. フォーマットを指定する水平軸お
よび垂直軸パラメータの値を両方
入力します。

スキャン・タイプを設定します。

同期タイプを設定します。

フレーム・レートの値を入力し
ます。

4. フォーマット名を入力して Save を
押すと、新しいフォーマットが保存
されます。

5. 作成したユーザ定義フォーマットを
使用するには、Format タブにある
User Defined Format チェックボック
スをオンにし、リスト・ボックスでそ
のユーザ定義フォーマットを選択
します。

入力信号フォーマットの設定 - VGA オプション

1. Configuration（設定） > Format
（フォーマット）を選択します。

Format（フォーマット）タブ画面が
表示されます。
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2. 測定する信号に適した解像度を
選択します。

3. 測定する信号のリフレッシュ・レー
トを選択します。選択した解像度
により、選択できないリフレッシュ・
レートがあります。

4. 信号のタイミング規格を選択しま
す。

カスタム・フォーマットの作成

Format（フォーマット）タブにリストされていないフォーマットをテストする必要がある場合は、ユーザ定義の
フォーマットを作成できます。

1. Configuration（設定） > Format
（フォーマット）を選択します。

Format（フォーマット）タブ画面が
表示されます。

2. 新しいフォーマットを追加するに
は、User Defined Format チェック
ボックスをオンにします。
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3. 次にそのパラメータを定義するに
は、Add を押します。

4. フォーマットを指定する水平軸お
よび垂直軸パラメータの値を両方
入力します。

同期極性を設定します。

リフレッシュ・レートの値を入力
します。

5. フォーマットの名前を入力して、
Save（保存）を選択し、新しいフォー
マットを保存します。

6. 独自に定義したフォーマットを使
いたい場合は、Format タブにある
User Defined Format チェックボック
スをオンにしてください。使いたい
フォーマットをリスト・ボックスから
選択します。

測定の選択

1. Configuration（設定） >
Measurements（測定）を選択
します。
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2. Measurements（測定）タブで使用
する測定を選択します。測定は 1
つまたは複数の組み合わせを選
択できます。

SD/HD オプション

VGA オプション

測定実行操作の設定

1. Configuration（設定） > Operation
（操作）を選択します。

SD/HD オプション

VGA オプション

Operation（操作）画面が表示され
ます。これらの設定は、機器のセッ
トアップ、およびRun（実行）ボタン
を選択したときの測定の取込み方
法を制御します。

SD/HD オプション

38 VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル



機器の概要

VGA オプション

2. 機器のセットアップと測定の実行方
法を選択します。

Setup & Run（セットアップと実行）は、機器の設定を行い、選択した各測定と測定取込みで測定
を実行します。異なる機器のセットアップを必要とする複数の測定を実行する場合にこのオプ
ションを使用します。

Setup Only（セットアップのみ）は、測定用に機器を設定しますが、測定は実行しません。このオプ
ションを使用して、カスタマイズされた設定をセットアップします。Run（実行）ボタンを押して設定を試
し、必要に応じて調整してから（水平スケールを変更するなど）、Run（実行）ボタンをもう一度選択しま
す。カスタマイズが終了したら、Run Only（実行のみ）設定を使用し、結果を収集します。

Run Only（実行のみ）は、既存の機器設定を使用して、測定を実行します。カスタム設定で測定を実
行する場合は、この設定を使用します（上記のSetup Only（セットアップのみ）を参照）。

3. アプリケーションが測定を取込む方
法（実行モード）を選択します。

Once（1回）は、平均化設定で決定されている数だけ選択した各測定を実行してから、測定を停止し
ます。これがデフォルト設定です。

Continuously（連続）は、連続して測定を実行します。測定を停止するには、Stop（停止）ボタンを
選択する必要があります。

Once & Report（1 回とレポート）は、平均化設定で決定されている数だけ選択した各測定を実行して
から、測定を停止してレポートを生成します。

4. 波形のAuto Scale（自動スケール）
を有効または無効にします。Auto
Scale（自動スケール）は、入力信号
ができる限り目盛内に入るように、
垂直スケール単位を調整します。
Auto Scale（自動スケール）は、選択
した各測定で 1 回実行されます。
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5. SD/HD オプション:トリガ用の同期
信号を持つチャンネルを選択しま
す。

間違ったトリガ・チャンネルを使用
すると、信号の警告が表示されま
す（信号の警告がオンの場合）。
(9 ページ 「入力信号の接続」 参
照)。

SD/HD オプション

6. 適切な Line Select 設定を選択しま
す。Single Line モードでは、各測
定が、1 本のライン（ライン 153 な
ど）で実行されます。Multiple Lines
モードでは、測定が、ラインのある
範囲で（ライン 153 ～ 185 など）で
実行されます。

Multiple Lines（複数ライン）を選択
すると、レポートがファイルに自動
的に保存されます。

7. VGA オプション：RGBHV 測定イン
タフェース・ユニットを使用する場
合は、Use MIU（MIUの使用）チェッ
クボックスを選択する必要がありま
す。

VGA オプション

8. VGA オプション：MIU を使用する
場合は、Sync Polarity 設定を無視
できます。
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H 同期および V 同期で指定した極性は、タイミング規格によって異なるため、VM シリーズ・システムは、
その極性を自動的に判断するために、H および V 同期信号を接続するように要求します。同期信号の
極性が判断されると、測定サイクルが開始されます。"極性テスト" は、各測定サイクルの初めに実行さ
れます。各測定サイクルの初めにこのテストを実行しないようにするには、Auto Detect を選択した状態
で、測定を 1 回実行します。Auto Detect を選択した状態で 1 回の測定サイクルを実行すると、Auto
Detect の選択を解除しても、極性テストのために信号を変えるように要求されなくなります（VM シリー
ズ・システムが同期信号の極性を記憶します）。被測定装置でフォーマットのセットアップを変更した場合
は、必ずAuto Detect を選択した状態で、測定サイクルを完了してください。

9. 表示する警告メッセージを選択し
ます。

警告について詳しくは、『VM シリー
ズ・ビデオ測定システム・ユーザ・
マニュアル』を参照してください。
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測定の実行と表示
測定を実行する前に、必ず信号フォーマットを選択してください。さらに、使用する測定を選択し、実
行オプションを設定します。

1. Run（実行）ボタンを選択します。
測定が実行され、一番最近に選択
した測定結果が表示されます。

SD/HD オプション

VGA オプション

2. 他の測定結果を表示するには、
Results（結果）メニューから測定を
選択します。 たとえば、同期測定
の結果を表示するには（SD/HD オ
プションのみ）、Results（結果） >
Sync（同期）を選択します。

SD/HD オプション

VGA オプション

3. 実行操作をContinuously（連続）に
設定している場合は、Stop（停止）
ボタンを押して、実行している測定
を停止します。
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オシロスコープの使用
測定を実行するため、または信号の特徴を表示するために、VM シリーズ・システムに備わっている標準の
オシロスコープ機能を使用するには、VM シリーズ・システム・ソフトウェアを非表示にします。VM シリーズ・
システム・ソフトウェアを終了する必要はありません。

1. VM シリーズ・システム・ソフトウェ
アを非表示にするには、Hide を選
択します。

VM シリーズ・システム・ソフトウェアを
非表示にすると、オシロスコープ画面
が全画面表示になります。VM シリー
ズ・システム・ソフトウェアが非表示で
あることは表示されません。

2. VM シリーズ・システム・ソフトウェ
アに戻るには、Analyze メニューの
Restore Application を選択します。
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信号問題のトラブルシューティング
測定の実行に問題がある場合は、問題の原因を判断するために役立つ警告またはエラー・メッセージが表
示されることがあります。次の表に、メッセージと可能性のある原因を示します。

SD/HD オプション警告メッセージ

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

1 Acquisition Problem（取込みの
問題）

機器がトリガできない、または信
号レベルが範囲外です。

すべての測定

2 Bar Measurements Inconclusive
（バー測定が不確定です）

機器が正しい同期を見つけられ
ないか、間違ったフォーマットが
選択されています。または、信
号が歪んでいます。

短時間歪みの測定

3 Channel Delay: Channel <x> &
<y>, Correlation Too Low（チャ
ンネル遅延:チャンネル<x> &
<y>、相関が低すぎます）

間違ったライン番号が設定され
ている、歪んだ信号、またはトラ
ンジションが少なすぎる不適切
な入力信号です。

チャンネル遅延の測
定

4 Channel Delay:Disjoint
Correlations Among Channels...
（チャンネル遅延:チャンネル間
で相関が失われました...）

チャンネル間で一致しないグ
ループ遅延があるか、不適切な
信号ソースです。

チャンネル遅延の測
定

5 Color Bars:<Color> Bar Not
Found（カラー・バー: <カラー>
バーが見つかりません）

間違ったライン番号が設定さ
れている、歪んだ信号、不正な
フォーマットが指定されている、
接続されているチャンネルの順
番が間違っている、不正なカラ
リメトリ、または過度の信号クロッ
ピングです。

カラー・バーの測定

6 Color Bars:Back Porch Reference
Questionable（カラー・バー:バッ
ク・ポーチのリファレンスに問題
があります）

信号が歪んでいます。 カラー・バーの測定

7 Frequency Response:Signal
Change: <freq1> ³ <freq2> MHz
（周波数応答：信号の変化：
<freq1> ³ <freq2> MHz）

信号のレベルが低すぎる、不正
な信号、信号に変化があります。

周波数応答の測定

8 Frequency Response Individual
Channel Errors: Channel <x>（周
波数応答の各チャンネル・エ
ラー:チャンネル<x>）

信号が歪んでいるか、信号にフ
ラグがありません。

周波数応答の測定

9 Frequency Response: Invalid
results for all channels（マルチ
バースト：全チャンネルの無効
な結果）

間違ったライン番号が設定され
ている、不適切な入力信号、不
正な設定です。

周波数応答の測定

10 Multiburst:Signal Change:
<freq1> ³ <freq2> MHz（マルチ
バースト：信号の変化： <freq1>
³ <freq2> MHz）

信号のレベルが低すぎる、不正
な信号、信号に変化があります。

マルチバーストの測
定
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SD/HD オプション警告メッセージ （続く）

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

11 Multiburst:Individual Channel
Errors: Channel <x>: Flag <=
0 mV（マルチバースト：個々の
チャンネル・エラー：チャンネル
<x> ：フラグ <= 0 mV）

信号が歪んでいるか、信号にフ
ラグがありません。

マルチバーストの測
定

12 Multiburst:Individual Channel
Errors: Channel <x>: burst
<n>:not detected（マルチバー
スト:個々のチャンネル・エラー:
チャンネル<x> ：バースト<n>:が
検出されません）

信号レベルが低すぎる、歪んだ
信号、6 周波数パケットに満た
ない入力信号、信号の過度のク
ロッピングがあります。

マルチバーストの測
定

13 Multiburst: Invalid results for all
channels（マルチバースト：全チャ
ンネルの無効な結果）

間違ったライン番号が設定され
ている、不適切な入力信号、不
正な設定です。

マルチバーストの測
定

14 Noise:Signal Change: Chan <x>
（ノイズ：信号の変化：チャンネ
ル<x>）

測定中に信号が変化しました。 ノイズの測定

15 Noise:Invalid results for all
channels.（ノイズ：全チャンネル
の無効な結果）

間違ったライン番号が設定され
ている、不適切な入力信号、ま
たは不正な設定です。

ノイズの測定

16 Nonlinearity:Invalid Results:
Channel <x>:No ramp or step
signal found（非直線性:無効な結
果:チャンネル <x>：ランプまたは
ステップ信号が見つかりません）

間違ったライン番号が設定され
ている、または不適切な入力信
号です。

非直線性の測定

17 Nonlinearity:Signal Change:
Channel <x>:（非直線性:信号の
変化:チャンネル <x>:）

測定中に信号が変化しました。 非直線性の測定

18 Short Time Distortion:Bar Start
Not Found（短時間の歪み：バー
の開始が見つかりません）

間違ったライン番号が設定され
ている、歪んだ信号、または不
正なフォーマットが選択されて
います。

短時間歪みの測定

19 Short Time Distortion:Bar End
Not Found（短時間の歪み：バー
の終わりが見つかりません）

間違ったライン番号が設定され
ている、歪んだ信号、または不
正なフォーマットが選択されて
います。

短時間歪みの測定

20 Short Time Distortion: Invalid
results for Channel<x>.（短時間
の歪み：チャンネル<x>の無効
な結果）

間違ったライン番号が設定され
ている、不適切な入力信号、ま
たは不正な設定です。

短時間歪みの測定

21 Sync Measurements Inconclusive
（同期測定が確定的ではありま
せん）

機器が正しい同期を見つけられ
ないか、間違ったフォーマットが
選択されています。または、信
号が歪んでいます。

同期の測定
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SD/HD オプション警告メッセージ （続く）

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

22 Sync Measurement: <n> Not
Found（同期の測定: <n>が見つ
かりません）

機器が正しい同期を見つけるこ
とができません。

同期の測定

23 2T pulse not found in luminance
component of signal（信号のルミ
ナンス・コンポーネントで 2T パ
ルスが見つかりません）

間違ったライン番号が設定され
ている、不適切な入力信号、ま
たは不正な設定です。

短時間歪みの測定

24 Writing over file <filename>（ファ
イル<filename>を上書きしていま
す）

機器が既存のファイルを上書
きしています。

設定の呼出し、レ
ポートの生成

25 Sync Acquisition Problem: Either
cannot trigger or the signal levels
are out of range.（同期の取込み
問題：トリガできないか、信号の
レベルが範囲外です）

トリガ

VGA オプション警告メッセージ

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

1 Sync edge locations questionable.
Make sure that the selected
format is correct.（同期エッジの
場所に問題があります。選択し
たフォーマットが正しいことを確
認してください。）

フォーマットが不正に設定され
ています。

H 同期、V 同期、お
よび V タイミングの
測定

2 H Timing: Incorrect signal
in Channel <1–3>. Use
Black-White-Black signal.Sync
edge locations questionable.
Make sure that the selected
format is correct.（H タイミング：
チャンネル<1-3>の不正な信号。
黒 / 白 / 黒信号を使用してく
ださい。同期エッジの場所に問
題があります。選択したフォー
マットが正しいことを確認してく
ださい。）

フォーマットが不正に設定され
ています。

H タイミングの測定

3 H Timing: Incorrect signal
in Channel <1–3>. Use
Black-White-Black signal.
（H タイミング：チャンネル<1-3>
の不正な信号。黒 / 白 / 黒信
号を使用してください。）

黒 / 白 / 黒信号が使用されて
いません。

H タイミングの測定
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VGA オプション警告メッセージ （続く）

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

4 Invalid Results:Acquisition
Problem:Either cannot trigger
or the signal levels are out of
range or acquired less than the
requested samples.（無効な結果:
取込みの問題:機器がトリガでき
ない、または信号レベルが範囲
外、または要求されたサンプル
数を取込めませんでした。）

Acquisition failed:Trigger
missing, format wrong or other
cause of failure to acquire signal.
（取込みの失敗:トリガがない、
不正なフォーマットまたはその
他の原因により、信号の取込み
が失敗しました。）

すべての測定

5 Linearity:Signal Change:
Channel <x>:（直線性:信号
の変化:チャンネル<x>:）

連続実行中の安定性問題：ラン
プが失われたか、ステップの数
が変更されました。

直線性の測定

6 Linearity:Signal Fidelity Problem:
Channel <x> Resolution
mismatch: Line A<x> bits,
Line B <y> bits:Steps not found
（直線性:信号の信頼性問題:
チャンネル<x>解像度の不一致:
ラインA<x>ビット、ラインB<y>ビッ
ト:ステップが見つかりません）

2 ライン・ランプで（ランプにおい
て、1 本目のラインの下部と 2
本目のラインの上部）、LSB 階
段波ランプのビット解像度が一
致しないか、合計のステップ数
が（2^n ― 1）ではありません。）

直線性の測定

7 Linearity:Error occurred in
switch accessory（直線性:スイッ
チ・アクセサリでエラーが発生し
ました）

RGBHV 測定インタフェース・ユ
ニットが正しく応答していませ
ん。

直線性の測定

8 Sync edge locations questionable.
Make sure that the selected
format is correct.（同期エッジの
場所に問題があります。選択し
たフォーマットが正しいことを確
認してください。）

フォーマットが不正に設定され
ています。

カラー・バー、ビデ
オ・チャンネルの
不一致、Ch-Ch ス
キュー、ルミナンス・
レベル、ビデオ・チャ
ンネルの不一致、V
同期、V タイミング、
ビデオ・トランゼント
の測定。

9 Color Bars:Yel-
low/Cyan/Green/Ma-
genta/Red/Blue/Black Bar
not found.（カラー・バー:黄 / シ
アン/ 緑 / マゼンタ / 赤 / 青 /
黒のバーが見つかりません。）

カラー・バー信号が使用されて
いません。

カラー・バーの測定

10 Ch-Ch Skew: Incorrect signal
in Channel <1–3>. Use the
Alternate White and Black bar
signal.（Ch-Ch スキュー:チャン
ネル<1-3>の不正な信号。白と
黒交互のバー信号を使用して
ください。）

フォーマットが不正に設定され
ています。

Ch-Ch スキューの測
定
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VGA オプション警告メッセージ （続く）

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

11 Luma Levels: Incorrect signal
in Channel <1–3>. Use the
Alternate White and Black bar
signal.（ルミナンスのレベル：チャ
ンネル<1-3>の不正な信号。白
と黒交互のバー信号を使用して
ください。）

白と黒交互の信号が使用され
ていません。

ルミナンス・レベルの
測定

12 Video Transient: Incorrect signal
in Channel <1–3>. Use the
Alternate White & Black signal.
（ビデオ・トランゼント：チャンネ
ル<1-3>の不正な信号。白と黒
交互のバー信号を使用してくだ
さい。）

白と黒交互の信号が使用され
ていません。

ビデオ・トランゼント
の測定

13 H Sync Jitter:Sync edge locations
questionable.Make sure the
selected format is correct.（H 同
期ジッタ：同期エッジの場所に
問題があります。選択したフォー
マットが正しいことを確認してく
ださい。）

フォーマットが不正に設定され
ています。

H 同期ジッタの測定

14 Noise:Invalid results for some
channels.（ノイズ：一部のチャン
ネルの無効な結果）

間違ったライン番号が設定され
ている、不適切な入力信号、ま
たは不正な設定です。

ノイズの測定

15 Ch-Ch Mismatch: Incorrect
signal in Channel <1–3>.Use the
32–step Staircase signal in true
color mode.（Ch-Ch 不一致:チャ
ンネル<1-3>の不正な信号。
True Color モードで32 ステッ
プ階段波信号を使用してくださ
い。）

32 ステップ階段波信号が使用
されていません。

Ch-Ch 不一致の測
定

エラー・メッセージ

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

1 File Name Error:File doesn't
exist: <filename>（ファイル名エ
ラー:ファイルが存在しません:
<filename>）

選択した .vmset ファイルが存
在しません（C:\VMApps\ フォ
ルダ以外の場所にあるファイル
は、完全なパスで指定してくだ
さい）。

設定の呼出し

2 Cannot write file:file already
exists: <filename>（ファイルに書
き込めません：ファイルが存在し
ません：<filename>）

ファイルに書き込めるように
<filename>の名前を変更する必
要があります。

設定の保存、レポー
トの生成
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機器の概要

エラー・メッセージ （続く）

番号 テキスト 可能性のある原因
発生する可能性の
ある操作

3 File Name Error.Invalid
character(s) in file name（ファイ
ル名エラー。ファイル名に無効
な文字が含まれています）

ファイル名に無効な文字が含
まれています。無効な文字は、
“|”, “:”, “/”,“,”, “<”、“>”、
“*”、“\”、および“?”です。

設定の保存、レポー
トの生成

4 No Measurement Selected（測定
が選択されていません）

Configuration（設定） >
Measurements（測定）メニューで
測定が選択されていません。

測定の実行、レポー
トの生成

5 Cannot create Report.Not all
selected measures have been Run
（レポートを作成できません。選
択した測定の一部が実行され
ていません）

レポートを生成する前に測定を
実行し、完了させる必要があり
ます。

レポートの生成

6 Invalid Filename（無効なファイル
名）

ファイルが存在しないか、パスが
正しくありません。C:\VMApps
フォルダ以外の場所にあるファ
イルは、完全なパスで指定して
ください。

設定の呼出し、設定
の保存、レポートの
生成（GPIB を通して
呼び出す場合のみ）

7 Invalid Argument（不正な引数） 特定の GPIB コマンドで使用さ
れている引数が不適切です。

すべての GPIB コマ
ンド

8 Command Overflow（コマンドの
オーバーフロー）

GPIBコマンドの送信が速すぎ
ました。 コマンド間の遅延時間
を増やしてこの問題を解決する
か（100 ミリ秒の間隔を推奨）、
OPComplete でハンドシェイクを
使用します。

GPIB コマンドの送信
が速すぎた場合

9 Command Missed（コマンドが見
つかりません）

このエラーは、最後に送信され
たコマンドが処理されていない
可能性を示します。このため、
最近の（既知の）設定に戻り、
一番最近のコマンドを再送信し
てください。

GPIB コマンドの送信

10 Error occurred in configuring
MIU（MIU の設定でエラーが発
生しました）

MIU へのシリアル接続が不適切
であるか、CH1/CH2/CH3/CH4
コネクタ・ケーブルのいずれか
が VM シリーズ・システムから取
り外されています。

MIU を使用した測定
の実行
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基本的なカラー・バー測定 – SD/HD オプション
振幅測定は通常、カラー・バーのテスト信号を使用して実行されます。このテスト信号は、R'G'B' のコ
ンポーネントをオンとオフに切り替えて、8 種類の可能な色の組み合わせ（白、黄、シアン、緑、マゼン
タ、赤、青、および黒）をすべて生成します。カラー・バー・テスト信号には、さまざまな異なる形式があ
り、一般的には最大ダイナミック・レンジ 700 mV で 100%、または R'G'B' 振幅が 525 mV で 75% のいず
れの形式が使用されます。次の表は、さまざまな標準の 100% および 75% カラー・バーについて、コン
ポーネント Y'P'bP'r の振幅範囲を示しています。

さまざまな 100% のカラー・バー信号フォーマットについての振幅範囲

480p/576p 1080/720

カラー・
バー

R'
（mV）

G'
（mV）

B'
（mV）

Y'
（mV）

P'b
（mV）

P'r
（mV）

Y'
（mV）

P'b
（mV）

P'r
（mV）

白 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0

黄 700 700 0 620.2 -349.8 56.9 649.5 -350.0 32.1

シアン 0 700 700 490.7 118.0 -349.9 551.2 80.2 -350.0

緑 0 700 0 410.9 -231.7 -293.0 500.6 -269.8 -317.9

マゼンタ 700 0 700 289.1 231.7 293.0 199.4 269.8 317.9

赤 700 0 0 209.3 -118.0 349.9 148.8 -80.2 350.0

青 0 0 700 79.8 349.8 -56.9 50.5 350.0 -32.1

黒 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

さまざまな 75% カラー・バー信号フォーマットについての振幅範囲

480p/576p 1080/720

カラー・
バー

R'
（mV）

G'
（mV）

B'
（mV）

Y'
（mV）

P'b
（mV）

P'r
（mV）

Y'
（mV）

P'b
（mV）

P'r
（mV）

白 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0

黄 525 525 0 465.2 -262.3 42.7 487.1 -262.5 24.1

シアン 0 525 525 368.0 88.5 -262.4 413.4 60.2 -262.5

緑 0 525 0 308.2 -173.8 -219.7 375.5 -202.3 -238.4

マゼンタ 525 0 525 216.8 173.8 219.7 149.5 202.3 238.4

赤 525 0 0 157.0 -88.5 262.4 111.6 -60.2 262.5

青 0 0 525 59.9 262.3 -42.7 37.9 262.5 -24.1

黒 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

50 VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル



アプリケーション

テストする機器のタイプに応じて、実際の値での一定の変動が許容されます。たとえば、DVD プレーヤのプ
ログレッシブ出力では、全体としての測定結果を変化させることがあるセットアップを出力に取り入れることが
あります。コンポーネントのレベルでの変動によって、表示されるピクチャに異なる色相と彩度が生じる可能
性があります。カラー・バー・テスト信号を使用すると、チャンネル間のゲインの不均衡を調査し、信号の激し
いクリッピングを生じさせる可能性がある信号の歪みがないことを保証できます。

Tektronix のマトリックス・パターンは、100% のカラー・バー信号を使用して、各コンポーネントのダイナ
ミック・レンジの全体をテストします。カラー・バー・パターンは、マトリックス・パターンの上部、またはその
付近に置かれ、パターンが発生するライン番号は標準ごとに異なります。指定されたライン番号は、テ
スト・マトリックスを生成するために使用されるデフォルト値ですが、イメージ内のラインを異なる位置に
シフトする被測定システムもあります。

フォーマット 1080i 720p 480p 576p

ライン 21 - 84 26 - 153 43 - 106 45 - 108

位置 584 - 647

VM シリーズ・システムは、最初に 3 つの各チャンネルの相対的な振幅を識別することによって、カラー・
バー測定を実行します。8 つの振幅測定は各チャンネルで行われ、0.5 秒未満の時間で合計 24 の測定が
行われます。次の手順では、1080i 信号に対して実行された一般的な測定結果を示します。各バー・レベル
の振幅レベルは、バック・ポーチを基準として測定されます。振幅は、指定した各バー内で平均化された波
形値を使用して計算されます。このため、機器に対して手動セットアップが行われた場合は、機器の取り込
みウィンドウにビデオ全体が表示されるようにすることが大切です。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video
を選択します。

3. VM シリーズ・システム・アプリ
ケーションで、File > Recall Default
Setup を選択し、すべての設定を
出荷時のデフォルト値に戻します。

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。
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5. 入力信号のフォーマットを設定しま
す。(33 ページ 「入力信号フォー
マットの設定 - SD/HD オプション
」 参照)。

6. Configuration（設定）>
Measurements（測定）を選択
します。

デフォルトでは Color Bars（カラー・
バー）が選択されていることに注
意してください。

7. Run（実行）ボタンをクリックします。

測定が完了すると、結果画面が表
示されます。

基本的なカラー・バー測定 – VGA オプション
振幅測定は通常、カラー・バーのテスト信号を使用して実行されます。このテスト信号は、RGB のコンポー
ネントをオンとオフに切り替えて、8 種類の可能な色の組み合わせ（白、黄、シアン、緑、マゼンタ、赤、青、
および黒）をすべて生成します。カラー・バー・テスト信号には、さまざまな異なる形式があり、一般的には最
大ダイナミック・レンジ 700 mV で 100%、または RGB 振幅が 525 mV で 75% のいずれの形式が使用されま
す。次の表に、100% 時および 75% 時の RGB 信号の振幅を示します。
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100% カラー・バー信号の振幅

カラー・バー R（mV） G（mV） B（mV）

白 700 700 700

黄 700 700 0

シアン 0 700 700

緑 0 700 0

マゼンタ 700 0 700

赤 700 0 0

青 0 0 700

黒 0 0 0

75% カラー・バー信号フォーマットの振幅

カラー・バー R（mV） G（mV） B（mV）

白 700 700 700

黄 525 525 0

シアン 0 525 525

緑 0 525 0

マゼンタ 525 0 525

赤 525 0 0

青 0 0 525

黒 0 0 0

Tektronix のマトリックス・パターンは、100% のカラー・バー信号を使用して、各コンポーネントのダイナミッ
ク・レンジの全体をテストします。カラー・バー・パターンは、マトリックス・パターンの上部付近に置かれ、パ
ターンが発生するライン番号はフォーマットごとに異なります。次の表に、リフレッシュ・レートが 60 Hz のと
きにマトリックス信号内の異なるパターンが位置するライン番号を示します。他のリフレッシュ・レートに
ついては、実際の開始ライン番号が、リフレッシュ・レート 60 Hz の場合とは顕著に異なる場合がありま
す。他のリフレッシュ・レートでの特定のパターンに関して、アクティブなビデオ・ライン番号の位置につ
いては、VM シリーズ・システム・ソフトウェア CD-ROM に収録されている Microsoft Excel のファイル、
Matrix.xls を参照してください。このファイルには、サポートするすべてのリフレッシュ・レートについて、実
際のアクティブなビデオ・ライン番号のリストが記載されています。

リフレッシュ・レート 60 Hz（640x480～1280x1024）でのパターンに関するアクティブなビデオ・ライ
ン番号の位置

パターン 640x480 800x600 1024x768 1280x1024

半分白と半分黒 36 – 83 28 – 87 36 – 112 42 – 143

Nine Colorbars（9 つのカラー・バー） 84 – 179 88 – 207 113 – 265 144 – 348

32 ステップ 180 – 227 208 – 267 266 – 342 349 – 450

白と黒交互 228 – 275 268 - 327 343 - 419 451 -552

黒 / 白 / 黒 276 – 323 328 – 387 420 – 496 553 – 654

全面白 324 – 371 388 – 447 497 – 572 655 – 756
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リフレッシュ・レート 60 Hz（640x480～1280x1024）でのパターンに関するアクティブなビデオ・ライ
ン番号の位置 （続く）

パターン 640x480 800x600 1024x768 1280x1024

ランプ 372 – 467 448 – 567 573 – 726 757 – 962

半分白と半分黒 468 – 515 568 – 627 727 – 803 963 – 1065

リフレッシュ・レート 60 Hz（1600x1024～1900x1200）でのパターンに関するアクティブなビデオ・ライ
ン番号の位置

パターン 1600x1024 1600x1200 1920x1080 1920x1200

半分白と半分黒 36 – 132 50 – 169 38 – 140 43 – 162

Nine Colorbars（9 つのカラー・バー） 143 – 337 170 – 409 150 – 356 163 – 402

Staircase 347 – 439 410 – 529 366 – 464 403 – 522

白と黒交互 450 – 542 530 – 649 474 – 572 523 – 642

黒 / 白 / 黒 552 – 644 650 – 769 582 – 680 643–762

全面白 655 – 747 770 – 889 690 – 788 763 – 882

ランプ 757 – 951 890 – 1129 798 – 1004 883 – 1122

半分白と半分黒 962 – 1059 1130 – 1249 1014 – 1117 1123 – 1242

リフレッシュ・レート 60 Hz（1920x1440～2048x2048）でのパターンに関するアクティブなビデオ・ライ
ン番号の位置

パターン 1920x1440 2048x1536 2048x2048

半分白と半分黒 50 – 193 53 – 198 71 – 265

Nine Colorbars（9 つのカラー・バー） 194 – 481 213 –505 285 – 674

Staircase 482 – 625 520 – 659 695 – 879

白と黒交互 626 – 769 674 – 812 899 – 1084

黒 / 白 / 黒 770 –913 828 – 966 1104 – 1289

全面白 914 – 1057 981 – 1120 1309 – 1493

ランプ 1058 –1345 1135 –1427 1514 – 1903

半分白と半分黒 1346 – 1489 1442 – 1588 1923 –2118
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VM シリーズ・システムは、最初に 3 つの各チャンネルの相対的な振幅を識別することによって、カラー・
バー測定を実行します。8 つの振幅測定は各チャンネルで行われ、0.5 秒未満の時間で合計 24 の測定が
行われます。次の手順では、1024x768 信号に対して実行された一般的な測定結果を示します。各バー・レ
ベルの振幅レベルは、バック・ポーチを基準として測定されます。振幅は、指定した各バー内で平均化され
た波形値を使用して計算されます。このため、機器に対して手動セットアップが行われた場合は、機器の取
り込みウィンドウにビデオ全体が表示されるようにすることが大切です。

1. 機器の電源をオンにします。

2. Analyze > VM VGA Video を選択
します。

3. VM シリーズ・システム・アプリ
ケーションで、File > Recall Default
Setup を選択し、すべての設定を
出荷時のデフォルト値に戻します。

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

5. 入力信号のフォーマットを選択しま
す。(35 ページ 「入力信号フォー
マットの設定 - VGA オプション 」
参照)。

6. Configuration（設定）>
Measurements（測定）を選択
します。

デフォルトでは Color Bars（カラー・
バー）が選択されていることに注
意してください。
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7. Run（実行）ボタンをクリックします。

測定が完了すると、結果画面が表
示されます。

相対基準のカラー・バー測定の表示
VM シリーズ・システムでの測定結果は、測定値そのものを表示するほか、所定の値を基準とした相対値と
して表示することも可能です。相対的な値は、測定された値を基準値から減算して計算されます。相対
値で表示したい場合は、Configuration 画面の Reference & Limits タブにある、Enable Relative Results
をオンにしてください。基準値は、特別な CSV（カンマ区切りの値) テキスト・ファイルで指定されます。
VM シリーズ・システムには、編集可能なテンプレート・ファイルのセットが含まれているため、アプリケー
ションに適した基準値を指定することができます。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video
または VM VGA Video を選択しま
す。
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3. VM シリーズ・システム・アプリ
ケーションで、File > Recall Default
Setup を選択し、すべての設定を
出荷時のデフォルト値に戻します。

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

5. 入力信号のフォーマットを選択しま
す。(33 ページ 「入力信号フォー
マットの設定 - SD/HD オプション
」 参照)。 (35 ページ 「入力信号
フォーマットの設定 - VGA オプ
ション 」 参照)。

6. Configuration（設定）> Refefence &
Limits（基準と限界）を選択します。

7. Enable Relative Result Display（相
対的な結果表示を有効にする）に
チェックを入れます。

VM シリーズ・システム・アプリケー
ションのデフォルトでは、選択され
た信号フォーマットに一致するリ
ファレンス・ファイルが、提供された
テンプレートのセットから自動的に
選択されます。

8. Run（実行）ボタンをクリックします。
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測定が完了すると、結果画面が表
示されます。Relative（相対）タブと
Reference（基準）タブが選択可能に
なっていることに注意してください。

SD/HD オプション

VGA オプション
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9. Reference（基準）タブを選択し、相
対値の計算に使用された基準値を
表示します。

SD/HD オプション

VGA オプション
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10.Relative（相対）タブを選択し、 計
算された相対値を表示します。
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11. %（パーセント）オプション・ボタン
を選択し、測定値と基準値の差を
パーセントで表示します。

SD/HD オプション

VGA オプション
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リミット・テストを使用したカラー・バー測定の表示
VM シリーズ・システムでは、リミット値と比較して合否を示した測定結果を表示することができます。相対的
な測定と同様に、リミット値は CSV フォーマットのテキスト・ファイルで指定されます。VM シリーズ・システム
には、編集可能なテンプレート・ファイルのセットが含まれているため、アプリケーションに適したリミット値を
指定することができます。リミット値は、最大値と最小値から構成されます。測定された値が、最大および最
小のリミット値の間にある場合、リミット・テストに合格したと見なされます。測定された値が、最大および最小
のリミット値の外側にある場合、リミット・テストには不合格であったと見なされます。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video ま
たは VM VGA Video を選択しま
す。

3. File（ファイル）> Recall Default
Setup（デフォルト・セットアップの呼
出し）を選択し、すべての設定を出
荷時のデフォルト値に戻します。

SD/HD オプション

VGA オプション

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

5. 入力信号のフォーマットを選択しま
す。(8 ページ 「入力接続の要件 -
SD/HD オプション」 参照)。 (8 ペー
ジ 「入力接続の要件 - VGA オプ
ション」 参照)。
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6. Configuration（設定）> Refefence >
Limits（基準と限界）を選択します。

SD/HD オプション

VGA オプション

7. Enable Limit Testing（リミット・テスト
を有効にする）を選択します。

VM シリーズ・システム・アプリケー
ションのデフォルトでは、選択され
た信号フォーマットに一致するリ
ミット・ファイルが、提供されたテン
プレートのセットから自動的に選
択されます。

SD/HD オプション

VGA オプション

8. Run（実行）ボタンをクリックします。
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測定が完了すると、結果画面が表
示されます。Limits（限界）タブが
が選択可能になっていることに注
意してください。

リミット・テストが有効になっている
と、結果は緑色または赤色のテキ
ストで表示されます。緑色のテキ
ストは合格を示します（測定された
値が限界値を超えなかった)。赤
色のテキストは不合格を示します
（測定された値が最大値または最
小値を超えた)。

SD/HD オプション

VGA オプション
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9. Limits（限界）タブを選択し、使用さ
れた限界値を表示します。

min（最小）または max（最大）のい
ずれかを選択し、許容される最小
値および最大値として指定されて
いる限界を表示します。

SD/HD オプション

VGA オプション
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2 つの測定を使用したリミット・テストの実行
VM シリーズ・システムでは、一度に複数の測定を使用してリミット・テストを実行することができます。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video ま
たは VM VGA Video を選択します。

SD/HD オプション

3. File（ファイル）> Recall Default Setup
（デフォルト・セットアップの呼出し）
を選択し、すべての設定を出荷時
のデフォルト値に戻します。

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

5. 入力信号のフォーマットを選択しま
す。(33 ページ 「入力信号フォー
マットの設定 - SD/HD オプション
」 参照)。 (35 ページ 「入力信号
フォーマットの設定 - VGA オプショ
ン 」 参照)。
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6. Configuration（設定）> Refefence &
Limits（基準と限界）を選択します。

SD/HD オプション

VGA オプション

7. Enable Limit Testing（リミット・テスト
を有効にする）を選択します。

VM シリーズ・システム・アプリケー
ションのデフォルトでは、選択され
た信号フォーマットに一致するリ
ミット・ファイルが、提供されたテン
プレートのセットから自動的に選択
されます。

SD/HD オプション

VGA オプション

8. Measurements（測定）タブをクリック
し、実行する測定を選択します。
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9. 次のように 2 つの測定を選択しま
す。

SD/HD オプション：Color Bars と H
Sync を選択します。

SD/HD オプション

VGA オプション：Color Bars と
Luma Levels を選択します。

VGA オプション

10.Run（実行）ボタンをクリックします。

測定が開始されると、測定ステータ
ス画面が表示されます。測定が完
了すると、選択されている測定に関
して Pass（合格）または Fail（不合
格）が表示されます。

SD/HD オプション
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VGA オプション

11.選択した各測定の結果を表示する
には、Results（結果）メニューを選
択し、選択した測定のいずれかを
選択します。

選択した測定の結果画面が表示
されます。

SD/HD オプション
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VGA オプション
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12. もう 1 つの選択した測定の結果
を表示するには、Results（結果）メ
ニューを選択し、もう 1 つの測定を
選択します。

SD/HD オプション

VGA オプション

複数のラインにわたる測定の実施
VM シリーズ・システムで測定を行うときには、ライン番号によって測定を実行する場所（いつ測定を実行す
るか、と表現することもできます）を指定します（ルミナンス・レベルを測定する場合は、信号のアクティブ・ビ
デオ部分の内側で測定が行われるようにする必要があります）。複数のラインにわたって測定を行う必要が
生じることもあります（たとえば、レベルがディスプレイの上部から下部まで一定であることを検証する必要が
ある場合）。そのためには、Operations タブの Line Select の下にある Multi Lines 設定を使用します。

注： 一部の測定は、複数ライン・モードで使用することができません。
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すべてのラインで測定を行うことを指定できるため、多くの測定結果が得られることがあります。このため、
複数ライン・モードで実行したすべての測定の結果は、画面上に表示するのではなく、ファイルに保存
されます。結果のファイルは、RTF、CSV、または PDF フォーマットで保存できます。複数ラインでの測
定結果を確認するには、Microsoft Word や Excel、または Adobe Reader などの、VM シリーズ・システ
ム・アプリケーション以外のプログラムを使用する必要があります。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video ま
たは VM VGA Video を選択しま
す。

3. VM シリーズ・システム・アプリ
ケーションで、File > Recall Default
Setup を選択し、すべての設定を
出荷時のデフォルト値に戻します。

4. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

5. Configuration > Format を選択し、
必要ならばフォーマット設定も選
択します。

6. Configuration > Operation を選択
します。

VGA オプション
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7. Line Select（ライン選択）セクション
で Multi Lines（複数ライン）をクリッ
クします。

SD/HD オプション

VGA オプション

8. 測定方法と測定に使うラインの指
定は、Measurements タブで行いま
す。

SD/HD オプション

VGA オプション

各測定には、Start Line（開始ライ
ン）と End Line（終了ライン）という
2 つの入力ボックスがあります。 こ
れら 2 つのボックスを使用して、
測定を実行するラインの範囲を指
定します。
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9. 実行する測定の種類を選択するに
は、測定の名前の横にあるチェック
ボックスをクリックします。

VGA オプション

10. Start Line（開始ライン）ボックスと
End Line（終了ライン）ボックスにラ
イン番号を入力します。

VGA オプション

実行する測定の選択を終えた後
に、測定結果の保存先になるファ
イルの名前を指定する必要があり
ます。

11.結果を保存するファイルのパラメー
タを指定するには、次の操作を行
います。

Utilities（ユーティリティ） >
Generate Report（レポートの生
成）をクリックします。

Generate Report（レポートの生成）
パネルが表示されます。

12. ファイル名や保存場所を変更す
るには、Browse（参照）をクリックし
ます。 Save（保存）ダイアログが表
示されます。
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13. ファイル名を入力するか、ファイル
を保存する目的の場所に移動し
ます。

14.Files of type（ファイルの種類）に示
されるオプションから、レポートの
フォーマットを選択します。

15. Save（保存）をクリックします。

16.VGA オプション：レポート内に信
号の画面表示を保存する場合は、
Configuration >Operations を選択
します。Operations パネルが表示
されます。Report Mode の Embed
Screen Shot を選択します（Files of
type が Rich Text Format に設定さ
れた場合のみ使用できます）。

VGA オプション
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17.Run（実行）ボタンを選択して測定
を行います。

Run を選択すると、VM シリーズ・シ
ステムには選択した最初の測定の
結果ページが表示され、測定が開
始されます。表示されるライン番号
は、指定したラインそれぞれの測
定が行われるまで、各測定が実行
された後に増加します。この処理
は、選択した各測定に対して繰り
返されます。

18.測定の結果を表示するには、適
切なアプリケーションを使用してレ
ポート・ファイルを開きます。
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入力信号のピクチャとしての表示
VM シリーズ・システムは入力信号をピクチャとして表示できます。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video ま
たは VM VGA Video を選択しま
す。

3. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。

4. ピクチャ・ボタンを選択します。 こ
の操作でビデオ・モニタ・ウィンドウ
が開かれます。

5. 最大化ボタンをクリックし、ピクチャ
を全画面に拡大します。

VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル 77



アプリケーション

入力信号のベクトルスコープ・ウィンドウでの表示 – SD/HD オプショ
ンのみ

VM シリーズ・システムでは、信号のカラー範囲をすばやく確認できるように、入力信号をベクトルスコープ・
ウィンドウで表示できます。

1. 機器の電源をオンにします。

2. Analyze > VM HD and SD Video を
選択します。

3. 信号を入力に接続します。(9 ペー
ジ 「入力信号の接続」 参照)。
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4. Vectorscope（ベクトルスコープ）ボ
タンを選択します。

この操作でビデオ・モニタ表示ウィ
ンドウが開かれます。

5. 最大化ボタンをクリックし、ベクトル
スコープ表示を全画面に拡大しま
す。

VM シリーズ・ビデオ測定システム・クイック・スタート・ユーザ・マニュアル 79



アプリケーション
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索引

English terms
Auto Scale（自動スケール）

ボタン, 39
Channel 1/4（チャンネル 1/4）

オプション・ボタン, 40
Continuously（連続）オプション・

ボタン, 39
Once & Report（1 回とレポート）

オプション・ボタン, 39
RGBHV 測定インタフェース・ユ

ニット
接続, 14

Run Only（実行のみ）オプショ
ン・ボタン, 39

Setup & Run（セットアップと実
行）オプション・ボタン, 39

Setup Only（セットアップのみ）
オプション・ボタン, 39

VESA テスト手順
バージョン, 31

あ
アクセサリ

スタンダード, 3
安全にご使用いただくため

に, iii

え
エラーおよび警告メッセー

ジ, 44

お
オシロスコープ

使用, 43
オシロスコープの使用, 43

オプション・ボタン
Auto Scale（自動スケー

ル）のEnabled（有効
化）, 39

Channel 4（チャンネル
4）, 40

Continuously（連続）, 39
Once & Report（1 回とレ

ポート）, 39
Once（1回）, 39
Run Mode（実行モード）, 39
Run Only（実行のみ）, 39
Setup & Run（セットアップと

実行）, 39
Setup Only（セットアップの

み）, 39

か
開始ライン番号

マトリックス信号, 53
関連マニュアル, vi

け
警告およびエラー・メッセー

ジ, 44

こ
校正, 21
合否テスト, 62
後部パネル・マップ, 7
コントロール・パネル, 6

し
仕様

電源, 4
動作, 4

信号
接続, 9

信号の接続, 9

す
スイッチ・アクセサリ, 40
スタンダード・アクセサリ, 1, 3

せ
設定

警告, 41
測定実行操作, 38
入力信号フォーマット, 33,

35
前面パネル・マップ, 6

そ
操作

設定, 38
相対基準の測定, 56
測定

実行, 31
選択, 37

測定結果の表示, 42
測定の実行, 42
測定の選択, 37
側面パネル・マップ, 7
ソフトウェア・アップグレード, vi

た
対応オシロスコープ, v
対応機器, v

て
電源

要件, 4

と
同期用ピックオフ

接続, 9
同期ピックオフ

補正, 21
同期用ピックオフの補正, 21
動作仕様, 4

に
入力信号フォーマット

設定, 33, 35
入力の要件, 8
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ね
ネットワーク接続, 5

ひ
ピクチャ表示, 77
表示される警告のタイプ, 41

ふ
複数ライン, 71

へ
ベクトルスコープの表示, 78

ほ
ボタン

App（表示）, 30
Exit（終了）, 30
Hide(隠す）, 29
Picture（ピクチャ）, 29
Run（実行）, 29
Stop（停止）, 29
Vectorscope（ベクトルス

コープ）, 29

ま
マトリックス信号

説明, 25
マトリックスの信号パターン

開始ライン, 53
マニュアル, vi

め
メッセージ, 44

ゆ
ユーザ定義フォーマット

作成, 34, 36

ら
ライン番号

開始, 53

り
リミット・テスト, 62, 66
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